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INTRODUCTION 
 

  This manual is laid out in a logical progression of a model construction. Beginning with the 
database; manipulating objects; then on to drawing of 2D curves. Converting those curves into 3D 
objects, and then copying, cutting/joining objects and finally slicing for production. 
 
When JewelCAD is opened, the screen should look something like this: 
 

 
 

  The default settings have the grid at 10 units each. The positions of the toolbars can be changed by 
holding the left mouse button down over a toolbar (but not clicking on a button) and dragging the 
toolbar to its new position. 
 

+ Left Mouse Button (LM) and drag. 

 
  All of the buttons shown are shortcuts for functions, which can also be activated using the drop-
down menus. The buttons are grouped according to their menu. Ie: Copy Menu contains Cut & 
Paste, Vertical Mirror Copy etc, Copy toolbar contains these as well. 
  There is a table of buttons, with a short description of their uses at the back of this manual. 
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THE CAD WORLD
 

  The “world” in JewelCAD is just like ours: 3-Dimensional. Everything in JewelCAD has three 
references: X, Y and Z. The computer uses dimensions in these 3 axes ,(co-ordinates), to define 
points on the objects. 
 
  The views are standard 3rd-angle orthographic projection. Ie: 
 

 
 
  The X-, Y- and Z-axes run through these views as follows: 
 
Front View: X-axis is horizontal, Z-axis is vertical 
Top View: X-axis is horizontal, Y-axis is vertical 
RS View: Y-axis is horizontal, Z-axis is vertical 
 
  There is a “centre” to this world, called the World Origin, where the axes meet. 
  Most of the functions work with the World Origin as a reference point. 
  When drawing in CAD, you must remember that the drawing is ALWAYS 3D. What you do in 
one view may very well alter another view. 
 
 Also, it is important to remember that ‘drawing’ on a computer is not like drawing with paper and 
pencil. Everything on the computer must be accurate. You cannot, for example, extend a line by 
drawing another on top of it, as you might on paper. If you wish to join 2 lines, you must follow a 
‘formal’ procedure, it is not sufficient to draw one from the end of the previous. If you are asked to 
‘close’ a curve, this must also be done by the set procedure, and not by placing a point on top of 
another. This is an important feature of 3D modelling. 
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JEWELCAD ENTITIES 
 

 
CV: 

Control Vertices. The points that JewelCAD use to define the shape of the objects and 
curves . 

 
CURVE: 

The general term for 2D shapes, which can be straight lines, circles, curves etc. 
 
SURFACE: 
 A 3D object constructed from 2D curves. 
 
T-LINE: 
Construction lines used to define general boundaries. Cannot be altered once set 
 
JEWEL: 

An object, whose shape is already set and can only be altered by the Transform functions 
(Move/Size/Flip/Roll) 
(see “Miscellaneous Menu”)  

 
BOOLEAN OBJECT: 

An object made by the joining of 2 or more objets by a Boolean operation. (see “Boolean 
Menu”)  

 
BLOCK: 

An object made by the Block function. Has no CVs, and can only be altered by the 
Transform functions. 

 (see “Miscellaneous Menu”)  
 
FACET OBJECT: 
 An imported object, usually from STL or DXF format. 
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FILE MENU 
 

NEW: 
 Clear screen and start a new JewelCAD drawing.  
 

� Hotkey Hit [Ctrl + N] keys to create a new drawing 

 
OPEN: 
 Clear screen and open an existing drawing 
 

� Hotkey Hit [Ctrl + O] keys to open an existing drawing 

 
INSERT: 
 Bring an existing drawing into the present drawing 
 
SAVE: 
 Save drawing as the current open JewelCAD file 
 

� Hotkey Hit [Ctrl + S] keys to save a drawing 

 
SAVE AS: 
 Save drawing as a new JewelCAD file 
 
SAVE VIEWS: 
 Save the present View as a .BMP file 
 
DATABASE: 
 Open the Database 
 

� Hotkey Hit [B] key to open Database 

 
IMPORT: 
 Bring a file of a different format (ie. STL, DXF etc) into the drawing 
 
EXPORT: 
 Save the present drawing as a different format (ie. STL, DXF, IGES, JCV etc) 
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CONFIGURATION: 
 

Colours: 
Change the colours of Axes, Picked Colour etc 

 
1. Click on colour to be changed 
2. Colour Box will appear. 

 
3. Choose new colour and click “OK”  

 
Directories: 

Change the location of the database and 
material directories. Click on the 
“Database” and “Material” buttons to 
browse for the location. 

 
 
 

Hotkeys: 
 Change/create new hotkeys. 
 

1. Select the function you want to 
set/change the hotkey for. 

2. Click on “Define Hotkey”.  
3. Hotkey window will appear.  
4. Change letter and chose 

whether a Ctrl or Shift has to 
be held at the same time. 

5. Click “OK”.  
 

Load/Save Hotkey File: 
 Allows you to save the hotkey 
setup. Good for multiple users of the 
one program. Each user can have 
his/her own hotkeys. 

To Save hotkey file: 
1. Click on Save Hotkey File button 
2. Change “Save In”  box to drive, folder etc where you want to save it. 
3. Type name for file in “Filename” box. Eg. Bobskeys.hky  
4. Click “OK”  

To Load hotkey file: 
1. Click on Load Hotkey File button 
2. Browse to find the file. 
3. Select hotkey file 
4. Click “OK”  
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LANGUAGE: 
Allows you to change the language used in the program. Default is English. Can choose 
between Traditional and Simplified Chinese, French, German and Greek 

 
EXIT: 
 Exits the program 
 

� Hotkey Hit [Alt + F4] keys to close JewelCAD 
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EDIT MENU 
 

UNDO: 
 Un-do the previous action. Does not undo View changes. 
 

� Hotkey Hit [Ctrl + Z] keys to undo the last action 

 
REDO: 

Re-do an action. Redo list is wiped when, after undoing, another operation is performed. 
 

� Hotkey Hit [Ctrl + Y] keys to redo the last action 

 
DELETE: 
 Delete all selected objects. Does not work on CVs. 
 

� Hotkey Hit [Delete] key to delete selected objects 

 
UNDELETE: 
 Undo the previous delete action. 
 
HIDE: 
 Move objects into the main hidden layer. 
 
UNHIDE: 
 Move all objects from the main hidden layer into the visible layer. 
 
SWAP HIDE: 
 Swap the contents of the hidden and visible layers 
 
HIDE CV: 

Hide the CVs of a curve or surface.  
 

SHOW CV: 
 Show the CVs of a curve/surface. 
 
HIDE JEWEL: 

Move all objects designated as Jewels to the hidden layer. Includes jewels brought in by the 
Misc > Jewel function and objects designated as a Jewel. 

 
SHOW JEWEL: 
 Move all objects designated as Jewels to the visible layer. 
 
BE JEWEL: 
 Designate an object as a Jewel 
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NOT JEWEL: 
 Designate an object as not a Jewel 
 
SUPER SUBTRACTER: 

Make the selected object a super subtractor. IE removes material from other objects without 
the need for Boolean operation 

 
NOT SUPER SUBTRACTER: 
 Make the selected object cease to be a Super Subtracter 
 
DEFORMABLE: 
 Make the selected objects deformable 
 
NON-DEFORMABLE: 

Make the selected objects non-deformable. Ie: the object itself will not be altered by the 
deform functions, or by projection operations. 

 
OBJECT LAYERS: 

Assigns an object(s) to a layer. Useful for 
defining object groups.  
Every layer has a “Visible” and “Editable” 
property. Make sure these are turned on/off 
as required. 
To move an object to a hidden layer: 

1. Select Object 
2. Click on Edit > Object Layer 
3. Make sure that “Change Layer 

of Picked Object” is ticked  
4. Select layer to move object to. 
5. Change name of layer, if 

required. Eg: “Setting”  
6. Click “OK”  

If the object layer is still set to visible, the 
wires of the object will be the colour of that 
layer. 
 
Load/Save Layer File: 
 Saves the Visible/Editable/Name 
properties of the layers. Good for multiple 
users, each user can have his/her own setup 
of the layers. 
To Save/Load layer properties: 

1. Click on Load/Save Layer File button 
2. Change “Save In” box to drive, folder etc” where you want to save to/load 

from. To Load, select file to load. To Save, type name in “Filename” box.  
3. Click “OK”  
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MATERIAL: 
 

Opens the Material Database, allowing 
you to change the object’s material . 
 
1. Select object to change. 
2. Select “Material”  
3. Click on new material. 

   
  
 
 
 
 
CREATE/EDIT MATERIAL: 

 
  Opens a dialogue box for creating new or 
editing materials. 
 

 Base Colour: 
  Click on colour box to change. 
Get Object Material: 
Click to retrieve an existing object’s 

material settings. 
Mapping: 
  The images used to create the illusion of 
texture etc. (.BMP) 
   
Appearance: 

 Alter outside appearance. 
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VIEW MENU 
 

  As everything in JewelCAD is always 3D, the drawing can be viewed from any angle. The View 
Menu allows you to chose the way you want to look at an object, including direction, shading, and 
zooming. 
 
BACKGROUND: 
 

To change the look of the background, or to trace a scanned object. 
 

 

Blank Background: Uses the default background. 
 
Otherwise: 
Click “Browse” to locate a picture for the background.  
Actual Size:  

Shows the image at actual size 
Fit to View’s Width:  

Resizes the image proportionally until it is the same 
as the view’s  
width. 

Fit to View’s Height:  
Resizes the image proportionally until it is the same 
as the view’s height.  

Fit to View’s Width and Height:  
Resizes the image until it is the same as the view’s 
width and height. (Note: this will distort the image.) 

 
Auto Fit:  

Resizes the image so it just fits inside the view. Does not distort the image. 
Locked To View:  

Locks the image to the view, so image will be panned and zoomed together with the view. 
Image Centre:  

Allows you to determine which part of the image is at the world origin.  
1. Click the “Image Centre” button. The menu will disappear.  
2. Hold the mouse button down and drag to where you want the new centre to be 
3. Release mouse button. 

Image Scale:  
Allows you to scale a picture from its original size. 

Reset:  
Resets the Image Centre and Image Scale figures to the default settings. 

 
GRID SETTINGS: 
 

Allows you to alter settings for the grid. 
 

Grid Spacing: default is 10 units. 
 

No Grid: removes grid from drawing. Axes will remain. 
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FINE SNAP: 
  
 Increases the resolution of the snap function. (usually off for most operations)  
 

� Hotkey Hit [Z] key to activate Fine Snapping 

 
COLOURINGS / VIEWS: 
 

The different colouring modes �Hotkeys 
NORMAL WIRE FRAME: 
QUICK WIRE FRAME: 
MESH WIRE FRAME: 
FAST SHADING: 
SHADING IN COLOUR: 
RENDERING: 

W 
Q 
E 
A 
S 
D 

  

The different viewing directions �Hotkeys 
FRONT VIEW (X/Y): 
RIGHT VIEW 
TOP VIEW 
BACK VIEW 
LEFT VIEW 
BOTTOM VIEW 
3 DIMENSIONAL VIEW 
FRONT AND RIGHT VIEWS 
FRONT AND TOP VIEWS 
FOUR VIEWS (Front/Top/Right/3D) 
FOUR VIEWS (Back/Left/Bottom/3D) 

F 
R 
T 
K 
L 
M 
3 

 
Click on the buttons to change between views / colourings. 

 
NEW VIEW: 
  
 Opens a new view window 
 
PAN VIEW: 
 
 Moves the view either Up, Down, Left or Right 
 

� Hotkey Hold [Tab] + [Ctrl] keys down. Click Left mouse button and drag to Pan 
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ZOOM VIEW: 
 
 Zooms in or out. 
  
 Box: 
  Use a box to zoom a specific area.  

Click and hold where you want the new centre of the view to be and drag away. 
All: 
 Zoom so all objects, regardless of position, are visible in one view 
1:1: 
 Zoom to actual size. Requires calibrating. 
Calibrate: 
 Calibrates the 1:1 zoom. 

1. Zoom In/Out until grid is 1cm on the 
screen. Use a ruler to measure it. 

2. Select Calibrate and click “Factor from 
Current View” then “OK”.  

 

� Hotkey Hold [Tab] key down. Click Right mouse button and drag to Zoom 

 
FLIP VIEW: 
 
 Flips 3D view up/down, left/right 
 
ROLL VIEW: 
 
 Rolls 3D view to the left/right 
 
 
RESET VIEW: 

 
Changes View back to default, regardless of objects’ positions.  

 
TOOLBARS: 
  

Allows you to choose which toolbars are shown. Click name to activate/de-activate.  
  

Reset: Resets toolbars to default 
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PICK MENU 
 

  In order to work on an object/curve/cv, it must be ‘selected’/‘picked’. The default colour of a 
picked/selected object is white. 
 
SELECTING METHODS: 
 
Clicking: 

To select 
1. Move the curser over one of the lines and click the Left Mouse Button. 
2. Continue clicking on other objects to select them too.  

 
To de-select 
1. Click on a selected (white) line: object will turn pale blue. 
2. To de-select all objects, click Right Mouse Button. 

 
Dragging: 

To select 
1. Hold mouse button down and drag box through object lines. 

 
To de-select 
1. Hold mouse button down and drag box through object lines: object will turn pale blue. 

 
De-select all objects: 
 Click the right mouse button anywhere on the screen. 
 
PICK:  
 Allows you to select/de-select entities. The “Normal” state of JewelCAD.  
 

� Hotkey Hit [Spacebar] to return to Picking mode 

 
PICK CV: 

Allows you to select/de-select CVs individually. Used to edit surfaces and curves. 
 

� Hotkey 
Hold [Shift] Key down to Pick CVs. Release [Shift] key to return to Picking 
mode 

 
PICK T-LINE: 

Allows you to select/de-select T-Lines 
 

 
ALL: 

Select everything 
 

CURVE:   
Select all curves 
 

SURFACE:   
Select all surfaces 
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BOOLEAN:   

Select all Boolean objects 
 

BLOCK:   
Select all Block objects 
 

JEWEL:  
 Select all Jewels 
 
FACET OBJECT:  

Select all Facet Objects (eg imported STL files) 
 

T-LINE:  
Select all T-Lines 
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DATABASE:
 

LOCATION: 
 
The files in the JewelCAD database are located in the JewelCAD directory, in the database folder: 
 

Files are in here…. 
 
 
 
 
The directories/names you see in the database are the same as in 
Windows Explorer. 

The contents and names in the database can be altered through Windows Explorer. 
See “File Menu – Directories” to change location.  
 
ACCESSING THE DATABASE: 
 
To access the database through JewelCAD, press the “B” button or, using the menus:  
 
File > Database 
 
ADDING TO THE DATABASE: 
 
To save a drawing (complete or unfinished) to the database: 
 

1. File > Save As 
 
2. Change the “Save in” box to the “database” directory, then whichever directory within.  

 
3. Type a filename in the “File name” box.  

 
4. Click “OK”.  

 
SAVING PICTURES TO THE DATABASE: 
 
When a drawing/part is saved to the database, a picture must also be saved separately. 
After saving the JewelCAD file as above: 

1. Render the model and set to 3D view. 
2. misc>render to file 
3. Change the “Save in” box to the “database” directory, then whichever direc tory the 

JewelCAD drawing is in. 
Type the same filename as the JewelCAD drawing, it will be 
automatically designated a .BMP file. 

4. Click “Save”.  
. 
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TRANSFORM 
 

  The Transform functions allow you to move, rotate and resize objects. 
  The functions, with the exception of Roll, also have a secondary function, available by using the 
right mouse button instead of the left. 
 
  The Transform functions are also available through the Deform > Transform menu. Through the 
menu, you can specify a definite distance/angle etc to move the object, as well as being able to 
combine functions. 
 
 
 
 
 
 
 
 
 
 
 
Move:  

Moves the object the distance specified along each axis 
Size:  

Resizes the object in all axes in proportion, by this MULTIPLYER 
Scale:  

Resizes the object along each axis separately by the MULTIPLYER in each box 
Rotate:  

Rotates the object AROUND the axis in which the angle is typed. 
 
 
World Origin: 
 Use the World Origin as the reference point for the functions. 
 
Object Axis: 
 Use the Object Axis as the reference point for the functions. 
 
Combining Functions: 
 To combine functions (eg roll 30º move up 10mm and resize x2 all at once), can be used 
simultaneously by selecting the relevant function button. 
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MOVE: 
 
Left Mouse Button: 
 

 

Select Objects (or CVs) 

 
Click on Move button 

 

Click and hold left mouse button down and drag to 
new position. 
Will move either vertically or horizontally. 

 
Right Mouse Button: 
 

 

Select Objects (or CVs) 

 
Click on Move button 

 

Click and hold right mouse button down and drag to 
new position. 
Will move in any direction. 
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SIZE: 
 
Left Mouse Button: 
 

 

Select Objects (or CVs) 

 
Click on Size button 

 

Click and drag horizontally or vertically. 
Changes along all axes proportionally. 

 
Right Mouse Button (Scale): 
 

 

Select Objects (or CVs) 

 
Click on Size button 

 

Click and drag horizontally or vertically. 
Will resize only one dimension. 

 
Size and scale both work by proportion, from the world origin. (X0Y0Z0). Therefore, 

if they are remote from the world origin they may move when being changed. This can be 
avoided by setting clicking ‘deform’>’object axis’
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FLIP: 
 
Left Mouse Button: 
 

 

Select objects (or CVs) 

 
Click on Flip button 

 

Click and drag across horizontal/vertical 
axis. 
Will flip around the axis you cross. 

 
Right Mouse Button: 
 

 

Select objects/ (or CVs) 

 
Click on Flip button 

 

Click and drag. 
Will combine the up/down flip with the 
left/right flip.. 

 

� Hotkey Hit [Shift + (ÅÆÇÈ)] keys to flip selected objects 90º 



 

 

20 
ROLL: 
 

 

Select objects (or CVs) 

 
Click on Roll button 

 

Click and drag to roll objects (or CVs ) 
around world origin. 

 
 
OBJECT AXIS: 
 
  When an object is created, the computer remembers where the Z-axis was. When Object Axis is 
turned on, the computer ignores the normal axes, instead reverting to the axes running through the 
object when the object was created. 
 

Original Object 
(Z=Vertical) 

Sizing with Object Axis 
off (World Origin) 

Sizing with Object Axis 
on 
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COPY MENU 
 
CUT & PASTE: 
 

Cuts an object from the drawing and pastes it elsewhere 
 

  When pasting, if the view is in Wire frame, the pasted-object will be pasted in the same orientation 
as it was when cut. 
  If the view is in Shaded mode, the pasted-object can be pasted onto the shaded object, and remains 
‘normal’ to the surface, whatever the contour.  
  

Ie: The pasted-object should start at the world origin, (the position to which all database 
objects enter the view), then, if it is a gemstone, the girdle will be on the centre-line, and 
will ‘sit on’ the surface of the shaded object when pasted.  

 
 Before Cut & Pasting After Cut & Pasting 

In
 W

ir
e 

M
od

e 

  

In
 S

ha
di

ng
 M

od
e 
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Objects can be adjusted after pasting which, for example, can be important for the position of grains 
in pave setting. But this can only be done with the last object pasted. The ‘Undo’ function can be 
used to rectify some mistakes. 
 
To move a pasted object: 

1. Hold Shift key down 
2. Move curser over object. 
3. Click and hold either left or right mouse button down and move 

Note: Only works on the last object pasted. 
 
To resize a pasted object: 

1. Once pasted, hold Shift key down 
2. Click Left Mouse Button 
3. Drag towards/away from a centreline 

Note: Only works on the last object pasted. 
 
To rotate a pasted object: 

1. Once pasted, hold Shift key down 
2. Hold down Right Mouse Button 
3. Drag mouse to roll. Will roll around it’s own axis.  

Note: Only works on the last object pasted. 
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VERTICAL MIRROR COPY: 
 

Mirrors objects across the Vertical Axis 
 
1. Select object to be copied 
 
2. Click Vertical Mirror Copy button. 
 

 

 
Æ 

 
 
HORIZONTAL MIRROR COPY: 
 

Mirrors objects across the Horizontal Axis 
 
1. Select object to be copied 
 
2. Click Horizontal Mirror Copy button. 
 

 

 
Æ 
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REVOLVE 180º COPY: 
 
 Copies objects 180º around the origin 
 

1. Select object to be copied 
 
2. Click Revolve 180º Copy button. 

 

 

 
Æ 

 
 
 
CYCLE COPY: 
 

Copies objects across Vertical and Horizontal Axes 
 
1. Select object to be copied 
 
2. Click Cycle Copy button. 
 

 

 
Æ 
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EXTEND COPY: 
 

Copy objects a set distance away, in a straight line. 
 

 
 

No. to extend: 
  How many times to copy the objects. Includes the original. 
-- : (Horizontal): 
  The distance between copies, in the horizontal direction.(a minus number to move left) 
| : (Vertical): 
  The distance between copies in the vertical direction. ( a minus number to move down) 
+ : (In/Out): 
  The distance between copies in the In/Out direction. 
 
If you’re not sure about the measurements, when the Extend Copy dialog box is open, hold the 
mouse button down on any point on the object and drag to where you want that point to be on the 
next object. Left Mouse Button will give you up/down or left/right coordinates. Right Mouse 
Button will give you up/down and left/right coordinates. 
 

Left Mouse Button Right Mouse Button 

  
 
To Use: 
 

 

Select objects to copy 

  

         

Click “Extend Copy” button 
and change settings as 

necessary 
  

 

Click “OK”  
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REVOLVE COPY: 
 

Copy objects in a circle, by a chosen angle 
 

 
 

Number: 
  How many times to copy the objects. Includes the first. 
 
Degree: 
  The angle between the objects 
 
Full Revolution: 
  When checked, this function recalculates either the Number or Degree to equal 360º when the 
other is altered. 
 
Clockwise: 
  Copies the objects in a clockwise direction. 
 
To Use: 
 

1. Select object(s) to be copied. 
2. Click on “Revolve Copy” button.  
3. Change settings, as necessary. 
4. Click OK 

 
Eg. 

 

�
 

 
 

 

�
 

 

 
If you’re not sure about the measurements, when the Revolve Copy dialog box is open, hold the 
mouse button down on any point on the object and drag to where you want that point to be on the 
next object. You will notice a set of radii showing. These are the angles the objects will be copied 
by. Choose the one that is closest to the degree you want.
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TRANSFORM COPY: 
 
 Copy objects according to the Transform Functions. Click on a function to activate. 
 

 
 

Move:  
Moves the object the distance specified along each axis 

Size:  
Resizes the object in all axes in proportion, by this MULTIPLYER 

Scale:  
Resizes the object along each axis separately by the MULTIPLYER in each box 

Rotate:  
Rotates the object ARROUND the axis in which the angle is typed. 

 
 
World Origin: 
 Use the World Origin as the reference point for the functions. 
 
Object Axis: 
 Use the Object Axis as the reference point for the functions. 
 
Copy No: 
 The number of times an object gets copied. 
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To Use: 
 

 

Select object to be copied 

  

 

Copy > Transform 
Change settings as required. 

This example uses: Size + Rotate 
Size= 1.25  Rotate= 30º 

Copies= 5 
  

 

Click “OK”  
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DEFORM MENU: 
 
  BEND: 
 

Bends objects around the World Origin 
 

 

Select object, (or CVs) 

  

 
Click on Bend Button 

  

T
o 

U
se

: 

 

Click and hold left mouse button down 
and drag in the direction to be bent. 

 
When bending, the following rules must be recognised: 

1. Any part “above” the centreline will be stretched in length  
2. Any part on the centreline will remain the same length 
3. Any part “below” the centreline will be compressed in length  

Ie.  
 

 
 

 
The curve made by bending is part of a circle. As you bend further, the circle diameter 
becomes smaller. If you bend far enough, the end of the object will meet up as a circle. 

 

 

 
To get the desired affect, it may be necessary to move the object before bending
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BEND (2 Sides) 

 
Bends objects in two directions (domes object) 

 

 

Select object, (or CVs). 

  

 
Click on Bend (2 Sides) button 

  

T
o 

U
se

: 

 

Click and hold left mouse button down 
and drag in the direction to be bent. 
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TAPER 
 

Tapers an object, pivoting on the centreline 
 

 

Select object, (or CVs) 

  

 
Click on Taper button 

  

 

Click and hold left mouse button down 
and drag across the screen. Object will 
taper into/out in that direction 

 
TAPER (2 SIDES): 
 

Tapers an object in two directions, pivoting on the centreline 
 

 

Select object, (or CVs) 

  

 
Click on Taper (2 Sides) button 

  

 

Click and hold left mouse button 
down and drag across the screen. 
Object will taper into/out in that 
direction 

 



 

 

32 
SCALED TAPER: 
 

Tapers an object and resizes to keep proportions 
 

 

Select object, (or CVs) 

  

 
Click on Scaled Taper button 

  T
o 

U
se

: 

 

Click and hold left mouse button down 
and drag across the screen. Object will 
Scale-Taper into/out in that direction 

 
SCALED TAPER (2 SIDES): 
 

Tapers and object and resizes proportionately in two directions 
 

 

Select object, (or CVs) 

  

 
Click on Scaled Taper button 

  T
o 

U
se

: 

 

Click and hold left mouse button down 
and drag across the screen. Object will 
Scale-Taper into/out in that direction 

 
 
 



 

 

33 
SKEW: (LOZENGE) 
 
 Skews an object parallel to and pivoting on an axis 
 

 

Select object, (or CVs) 

  

 
Click on Skew button 

  T
o 

U
se

: 

 

Click and hold left mouse button down and drag 
across the screen. Object will Skew (lozenge) 
parallel to mouse movement. 

 
SKEW (2 SIDES): 
 
 Skews an object parallel to and pivoting on an axis, in two directions 
 

 

Select object, (or CVs) 

  

 
Click on Skew (2 Sides) button 

  T
o 

U
se

: 

 

Click and hold left mouse button down and drag 
across the screen. Object will Skew parallel to 
mouse movement 
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TWIST: 
 
 Twists an object around an axis 
 

 

Select object, (or CVs) 

  

 
Click on Twist button 

  T
o 

U
se

: 

 

Click and hold left mouse 
button down and drag across 
the axis to twist around 

 
SKEW-TWIST: 
 
 Combines Skew and Twist 
 Objects appear twisted from one side, but remain the same from the other. 
 

 

Select object, (or CVs) 

  

 
Click on Skew-Twist button 

  

T
o 

U
se

: 

 

Click and hold left mouse button 
down and drag across the axis to 
Skew-Twist around 
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WHIRL: 
 
 Rotates object around the World Origin 
 The further the point is from the World Origin, the further it is rotated 
 

 

Select object, (or CVs) 

  

 
Click on Whirl button 

  

T
o 

U
se

: 

 

Click and hold left mouse 
button down and drag across 
screen. 
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PROJECTION-MAP: 
 
 Projects objects/CVs onto another surface/curve, in a straight line 
 

Project Direction: 
Top: 
 Project onto the Top of the object 
Bottom: 

  Project onto the Bottom of the object 
Left: 

  Project onto the Left side of the object 
Right: 

  Project onto the Right side of the object 
Arbitrary: 

  Project in a user-defined direction 
 
Offset Base: 

Superimpose: Projects the object so it is the same distance from the surface/curve as it was 
from the axis. The projected object is deformed to suit the curvature of the 
second object, unless defined as nondeformable., as in gemstones. 

 
Just Touch: Projects everything that is selected, so it sits on the line. Used mostly on 

CV’s to change the sh ape of an object. 
Keep Surface Sections: 
 Preserves the shape of the Surface Section after projecting 
The ‘just touch’ function 
 

 

Select object CVs to 
be projected 

  

 
Click on ProjMap 
button 

  

 

Change settings to 
‘just touch’> “OK”  

  

T
o 

U
se

:  

 

Click on object to 
project onto 
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The ‘superimpose’ function 
 

 

Select object to be 
projected 

  

 
Click on ProjMap 
button 

  

 

Change settings to 
 
‘top’ and  
‘superimpose’  
 
‘OK’  

  

T
o 

U
se

:  

 

Click on object to 
project onto 
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UV MAP: 
 
 Maps objects onto a curve or surface. Will stretch/compress objects to fit. 
 

 
 
Mapping Direction and Extent: 
 Direction: The direction of the object used to map onto the curve/surface. 

Extent: The area to be mapped onto the curve/surface. The contents of this box are 
stretched/compressed to fit over the entire surface/curve. 

 
Auto Mapping Direction and Extent: 

Checked: Ignores user-defined mapping and extent settings and calculates them for 
itself. 

Unchecked: Uses user-defined settings. (See above) 
 
Uniformly mapping onto curve: 
 When checked, distributes objects evenly over the surface/curve.  

When not checked, will distribute objects according to density of CVs.  
More CVs = more objects 

 
Map onto ONE curve or surface: 
 Maps only onto the one curve/surface the user selects 
Map onto ALL unpicked curves or surfaces: 
 Maps objects onto all unpicked curves or surfaces. Makes copies as necessary. 
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Select object/CVs to be mapped 

  

 
Click on UVMap button 

  

 

Use default, (automatic) settings 
 “OK”  

  

T
o 

U
se

:  
M

ap
pi

ng
 to

 a
 C

ur
ve

 

 

Click on curve to map onto 
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CURVE Menu 
 

  There are a few ways of drawing a curve in JewelCAD, depending on what you want the finished 
curve to look like. 
 
  A curve is drawn by pressing the Left Mouse Button where you want a new point to be. If this is 
not possible, you can create the new point somewhere else and drag it over to where you want it. 
Points can be added at the beginning of a curve, at the end, or between two existing points. As the 
points affect the shape of the curve, you can alter the points to change the curve to what you want. 
  ie: adding a point to pull the curve in one direction. 
   
Every point in a curve is numbered, starting at ‘0’, and therefore the curve has a direction with CV 
number ‘0’ being the start point. This is used to determine ‘left’ and ‘right’ cur ves when using rail 
functions. 
 

Operation Mouse Button Used 
Create new point Left Mouse Button. Just click. 

Move an existing point Left Mouse Button. Hold Down over CV 
and drag to new position. 

Delete point Left Mouse Button held down, then click 
Right Mouse Button. 

Start a new curve 
In a drawing mode, hold Ctrl Key down. 
Click Left Mouse Button to begin new 
curve. 

Edit an existing curve 
In a drawing mode, hold Shift Key down. 
Click Left Mouse Button on existing 
curve. 

Make a curve sharper at a point 
(Multiple CV) Left Mouse Button, double-click on CV. 

 
HOW TO: 
 

1 

 

2 

 
3 

 

4 
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TYPES OF CURVES: 
 
SIMPLE CURVE: 
 

Draws a curve point-by-point. Good for non-symmetrical curves. 
 

1. Click on “Simple Curve” Button to enter the “Simple Curve” drawing mode.  
2. Click in the screen to begin the curve. Continue clicking to add points. 

 
1 

 

2 

 
3 

 

4 

 
 

 
VERTICAL MIRROR CURVE: 
 

Draws a curve, mirrored across the vertical axis. 
 

1. Click on “Vertical Mirror Curve” Button to enter the drawing mode.  
 
2. Click on one side of the centre-line and see the point mirrored across the centreline. 

Continue clicking to add points. 
 

1. 

 

2. 

 
3. 

 

4. 
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HORIZONTAL MIRROR CURVE: 
 

Draws a curve, mirrored across the horizontal axis. 
 

1. Click on “Hor izontal Mirror Curve” Button to enter the drawing mode.  
 
2. Click above or below the centre-line and see the point mirrored across the centreline. 

Continue clicking to add points. 
 

1. 

 

2. 

 
3. 

 

4. 

 
 
 

REVOLVE 180º CURVE 
 
Copies points, 180º rotated from each other. 

 
1. Click on “Revolve 180º Curve” button to enter drawing mode.  
 
2. Click in screen. Each point you draw will be rotated 180º around the centre-point. 

 
N.B. The line will ALWAYS go through the centre-point. 

 
1. 

 

2. 

 
3. 

 

4. 
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CYCLE CURVE: 

 
Points are mirrored across both axes. 

 
1. Click on “Cycle Cur ve” Button to enter drawing mode.  

 
2.  Click in screen. The point you draw will be mirrored across the vertical axis and across the 

horizontal axis. 
 

1. 

 

2. 

 
3. 

 

4. 

 
 
 
 

 
 
 

Exercises: 
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EXTEND CURVE: 
 

Creates a curve which is repeated a chosen number of times, at a chosen distance. 
 

 
 
No. to extend: 
  How many times to copy the points. Includes the first point. 
 
--(Horizontal): 
  The distance to copy, between points, in a horizontal direction. 
 
| (Vertical): 
  The distance to copy, between points, in a vertical direction. 
 
+ (In/Out): 
  The distance to copy, between points, in an in/out direction. 
 
To Use: 
 

1. Click on “Extend Curve” button.  
2. Change settings, as necessary. 
3. Click OK 
4. Click in screen. Every point drawn will be copied according to the settings. 
5. The position of the points can be adjusted by ‘dragging’ with the mouse.  

 

 
The above drawing was drawn with the following settings: 

No. to extend: 5 
Horizontal: 3 

Vertical: 0 
In/Out: 0 

 
Exercises: 
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REVOLVE CURVE: 
 

Copies points by a set degree, in a circle 
 

 
 
Number: 
 The number of times to copy. Included the first point. 
 
Degree: 
 The angle separating the copies. 
 
Full Revolution: 

If this is selected when either the number or degree is changed, the computer will calculate 
the other to equal 360º. 

 
Clockwise: 
 Copies points in a clock-wise direction. 
 
TO USE: 
 

1. Click on “Revolve Curve” Button to enter drawing mode.  
2. Change settings as necessary. 
3. Click OK 
4. Click in screen to begin drawing. 

 
This drawing was drawn with the following settings: 

 
Therefore, there are: 

16 copies, separated by 22.5º  (16 x 22.5 = 360º) 
 

Exercises: 
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CIRCLE: 

 
Draws a circle 

 

 

Diameter/Radius: Determines what dimension is being 
used. The measurement is typed in the box 
beside. 

No. of CV’s: 
Sets how many CV’s make up the circle. The 
more CV’s, the smoother the curve.  

First CV: 

  Puts the “0” CV on the right -hand side, 
on the horizontal axis. 
 

 Puts the “0” CV on the right -hand side, 
at 45 degree angle  

  
To Use: 
 

1. Click on “Circle” button.  
2. Change settings as necessary 
3. Click OK 
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TRANSFORM CURVE: 
 

Draws a curve by copying CVs according to the Transform functions 
 

 
 
Move:  

Moves the object the distance specified along each axis 
Size:  

Resizes the object in all axes in proportion, by this MULTIPLYER 
Scale:  

Resizes the object along each axis separately by the MULTIPLYER in each box 
Rotate:  

Rotates the object ARROUND the axis in which the angle is typed. 
 
Copy No.: 

The number of times a point gets copied. If there are 2, the function will not have much 
effect. 

 
Combining Functions: 

To combine functions (eg roll 30º move up 10mm and resize x2 all at once), click on the 
relevant function buttons and alter the numbers as required. To work with just one, click 
function button until other buttons deactivate. 

 
To Use: 
 

1. Click on “Curve” menu, then on “Transform”  
2. Change settings as necessary 
3. Click OK 
4. Click once in screen. Curve will be drawn from that point, as per your settings. 

 
This drawing was drawn with the following 
settings:  
Size + Rotate, Size: 2, Rotate: In/Out 90º 

 
  Point “0” is 1mm from the centre, point “2” is 
2mm (1mm x 2), point “3” is 4mm (2mm x 2), 
point “4” is 8mm (4mm x 2). Each is rotated 90º 
from the previous. 
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LINE: 
 
 Draws a 2mm long line, at a given angle.  
 

1. Select “Line” from Curve Menu.  
2. Specify degree, either by selecting one of the pre-sets or by typing it 

in 
3. Click ok 

 
 

POLYGON: 
 
 Draws a polygon, with a diameter of 2mm.  
 

1. Select “Polygon” from Curve Menu.  
2. Chose number of sides in the polygon 
3. Click “OK”  

 
No. of Sides: 
 The number of sides on the polygon 
 
First CV: 

   Puts the “0” CV on the right -hand side, on the 
horizontal axis. 

   Puts the “0” CV on the right -hand side, at 45 
degree angle.  

 
HELIX: 
 

Draws a helix, according to given settings 
 
Radius 1: 
 The radius at the beginning of the helix 
Radius 2: 
 The radius at the end of the helix 
Length: 
 The overall length of the helix 
No. of Turns: 
 The number of turns in the helix 
CV’s per Turn: 
 The number of CVs per turn of the helix 
Anti-Clockwise/Clockwise: 
 The direction the helix flows in.  
 

1. Select “Helix” from the Curve Menu.  
2. Change settings as required. 
3. Click “OK”  
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MORE CURVE OPERATIONS: 
 
ADJUST: 
 

Edit an existing curve as if it was Simple, Vert. Mirrored etc. 
 
CLOSE CURVE: 
 
 Joins the start- and end-points together, making the curve into a loop. 
 
OPEN CURVE: 
 
 Un-joins the start- and end-points. 
 
SKETCH: 
 
 Allows you to draw a freehand curve. The curve is then converted to have CVs etc. 
 
REVERSE: 
 
 Reverses the order of CV’s on the curve.  
 
DIVIDE CURVE: 
 

Multiplies the number of CV’s on a curve by a factor, without changing the shape.  
 
JOIN CURVE: 
 
 Joins two curves together into one. After this operation is selected, the curves need to be 
selected. The program will join the curves together from the end of one to the start of another: 

  �    
 
SPLIT CURVE: 
 

Will split a curve at a CV. The CV will then become the end of one curve and the start of the 
other. 

  �    
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OFFSET CURVE: 
 
 Creates a curve a set distance off another. 
 

  
Original Curve After offsetting 1mm 

 
IN BETWEEN CURVE: 
 
 Creates a curve half-way between two others 
 

  
Original Curves With Curve In Between 

 
 Original curves MUST have the same number of CVs before creating a curve In Between 
 
 
CURVE LENGTH: 
 
 Measures the length of a curve 
 
  



51 

 

SURFACE MENU 
 

JewelCad refers to 3D objects as ‘surfaces’, because it is a ‘Surface Modeller’. However, this 
manual uses the  expressions:- Surface; 3D object: and object, and all can be interpreted as the same 
thing. 
3D Object are constructed from least, two shapes: one being a cross-section and the other being the 
shape, (or ‘profile’), of the object itself. In JewelCAD, the cross -section curve is called the “V -
Curve” and the shape, (profile), curve is called the “U -Curve”.  
 

  
 

At least, two curves must be used to create a surface. JewelCAD sometimes has a pre-set shape as 
part of the function, so you only have to draw one curve. In other functions, you must draw ALL 
curves. 
UNLIKE OTHER 3D PROGRAMMES, THE PROFILE AND SECTION ARE DRAWN ON THE 
SAME VIEW (PLANE), AND THE ORIENTATION FIXED BY A TABLE,(called ‘surface 
extent’) WHEN CARRYING OUT THE SURFACE FUNCTIONS.  
Depending on which curves you can draw; you can use one of five surfacing functions: 
 

Extend Surface: 
Creates an object, extruded from a cross-section curve. U-Curves will be straight 
lines. The cross section curve must be closed. 

 
Horizontal/Vertical Revolve Surface: 

Revolves a closed cross-section curve around the vertical or horizontal axis, to create 
a circular object. (eg. A plain finger ring) 

 
Loft Surface:  

Joins 2 or more closed cross-section curves to create an object. 
 

Pipe Surface:  
Sweeps a closed cross-section curve along a single curve. 

 
Rail Surface: 

Where the boundaries of the shape, (profile), are drawn as curves and the cross-
section is put between these curves. 
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EXTEND SURFACE: 
 

Extrudes an object from a curve 
 

 
 
The function works by copying the section curve, so that there are 2 or more, and then ‘filling in’ 
between them 
Extend Number: 
 The number of sections (including the original). Must be no less than 2. 
 
-- (Horizontal) / | (Vertical) / + (In/Out): 

The direction(s) in which to extrude the curve. The measurement is between the cross-
sections, not overall. Directions are from the current View. 
 Horizontal: Across the screen. Left is negative, right is positive 
 Vertical: Up and down the screen. Up is positive, down is negative 

In/Out: Towards and away-from you. Towards in positive, away from you is 
negative. 

 
Changes the functions (Horiz, Vert, In/Out) to Length, Angle from Horizontal and Angle 
In/Out 
 Length:  Length of surface, at the angle 

Angle at Horiz: Angle up from Horizontal axis, rotating around the In/Out axis. 
Angle In/Out: Angle towards or away-from you. Rotates around the 

horizontal axis. 
To Use: 
 

 

Draw cross-section, using a Curve function. 
Make sure the curve is selected (white) 
 
The section must be closed by :- 
‘curve’>’close’  

  

 
Click on Extend Surface button 

  

 

Change settings, as necessary 
Click “OK”  
If the length is unknown, use the mouse to 
‘drag’ the length required on screen, and click 
OK 
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REVOLVE SURFACE 
 

Revolves a surface from a curve, around the vertical or horizontal 
axis 

 

 
 
Number: The number of times the cross-section is repeated around 

the surface. 
 

Degree: The angle separating the cross-sections 
 

Full Revolution: 
 Automatically calculates the degree/number when one is typed in, so they equal 360º 
 
Clockwise: Revolves the cross-section in a clockwise direction. 
 
 
The effect of more/less cross-sections: 
 

  
Three Cross-sections 12 Cross-sections 

 
 
To Use: 

 

 

Draw cross-section using a Curve function. 
Make sure the curve is selected (white). The 
curve must be closed. 

 or  
Click one of the Revolve Surface buttons 

 

Change settings as required. Click “OK”  
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LOFT SURFACE: 
 
 Joins curves/surfaces together to create a single surface 
 

 
 

Reverse Section: 
 Reverses the direction of numbers on the cross-section. 
 Only applies if Lofting curves. 
 
Reverse Surface: 
 Reverses the direction of numbers on the U-Curve of the surface that has just been selected. 
 Only applies if Lofting surface. 
 
Swap UV: 

Switches which curve is a U-Curve and which is a V-Curve in the surface that has just been 
selected. 

 
 
To Use: 
 

 

Draw cross-sections to join. Curves must 
be closed. 

 
Click on Loft Surface button 

 

Click each curve in turn, clicking 2 or 3 
times to make each curve a sharp corner 
if that is required. 

 

Click Surface Menu, then Close 
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PIPE SURFACE 
  
 Sweeps a cross-section along a curve. 
 

 
 

One Section: 
 Use only one cross-section for 
 the surface. 
Two Sections: 
 Begin with one cross-section and 
 end with another. 

Horizontal/Vertical Piping: 
 The piping orientation of the cross-
 section, in regards to the curve 

Circular Section: 
 Use a pre-set circular cross-
 section. 

Diameter/Radius: 
 Sets which dimension to use and 
 the size, for a circular cross-
 section. Use the drop- down menu 
 to choose between Diameter and 
 Radius 

 
To Use: 
 

 

Draw the path,(or pipe) and cross-
section (if required). Cross-section 
Curve must be closed, and MUST BE 
ON THE WORLD ORIGIN. 
Make sure the ‘path’ (or pipe) is 
selected (white) 

  

 
Click on “Pipe Surface” button  

  

           

Choose Vertical piping, or 
Diameter/Radius and size. 
Click “One Sec tion”, “Two Sections” 
or “Circular Section”  

  

 

Click on cross-section(s), if necessary 
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RAIL SURFACE 
 

Puts a cross-section between a set of curves (rails) 
 

 
 
Rail: 
 1 Rail: 
  Vertical:  Places the cross-section between the vertical axis and a curve 

Horizontal: Places the cross-section between the horizontal axis and a 
curve 

  Loop (world origin): Sweeps the cross-section between the WO and a curve 
Loop (loop center): Calculates the center of a loop and sweeps the cross-section 

between it and the curve 
 2 Rails: 

Scale: Places a cross-section between two rails, scaling width to 
height proportionately 

Semi-Scale: Places a cross-section between two rails. Cross-section 
remains original height 

 3 Rails: 
As for 2 rails, but the 3rd rail provides a variable contour, (height), to the top of the 
section. 

 4 Rails: 
As for 3 rails, but the 4th. Rail controlling the contour of the underside of the section. 

 
Section: 
 Single:  Use a single cross-section 

Dual: Gradually change from one cross-section at one end to another at the other 
end 

Mirror: Gradually change from one cross-section at either end, to another cross-
section in the middle 

Multiple: Change between many cross-sections and/or determine where the change 
occurs 

Circular: Automatically use a pre-set circular cross-section 
SCREEN PROMPTS, AT BOTTOM LEFT, GUIDE SELECTION OF THE RAILS WHEN 
PICKING.
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Section Extent: 
 This table controls the orientation of the cross section, even though it has been drawn on the 
same plane as the rails. The first, ( top left ), configuration is the default and is good for the majority 
of rail functions. 
 

 

Section between and on top of rails  

 

Section between and to right of rails 

     

 

Section between and vertically centred 
between rails 

 

 

Section between and horizontally 
centred between rails 

     

 

Section between and underneath rails  

 

Section between and to left of rails 

     

 

Section horizontally centred above one 
rail, width radius set by 2nd rail 

 

 

Section vertically centred, to the right 
of one rail, height radius set by 2nd rail. 

     

 

Section centred around one rail. Width 
radius set by 2nd rail. 

 

 

Section centred around one rail. Height 
radius set by 2nd rail. 

     

 

Section horizontally centred below one 
rail, width radius set by 2nd rail 

 

 

Section vertically centred, to the left of 
one rail, height radius set by 2nd rail. 

 
LEFT AND RIGHT RAILS 
 
  The screen prompts will ask you to pick ‘left’ and ‘right’ rails, which can b e important to get the 
result you want. The left and right are determined by the direction of the curves, which is always 

starting from CV ‘0’ .  
EG. In the picture, the direction of the curves is left to 
right, ( ‘0’ to ‘4’) therefore the lower of the 2 r ails is the 
left rail 
 
If the left and right rails were to be chosen in reverse, 
the cross-section would be upside-down, underneath the 
rails. 
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To Use: 
 

 

Draw curve(s). 
Draw cross-section(s) 

  

 
Click on Rail button 

  

 

Change settings as necessary. 
Click “OK”  

  

 

Click on rail(s) 

  

 

Click on Cross-section(s) 

  

 

When you’ve selected the last cross -
section, the surface will be created. 
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TRANSFORM SURFACE: 
 
Sweeps a cross-section according to the transform functions 
 

 
 
Move/Size/Scale/Rotate: 
 The Transform functions being performed on the sections 
 
  Move:  Moves each section a distance from the previous 
  Size:  Resizes each section proportionately from the previous 
  Scale:  Resizes in one direction, each section from the previous 
  Rotate: Rotates each section an angle from the previous 
 
Horizontal / Vertical / In/Out: 
 The factors/measurements by which the functions are performed 
 
Copy No.: 
 The number of times the section is copied to create the surface. Must be at least 2. 
 
Combining Functions: 
 To perform multiple functions at the same time (ie. Move 3mm, rotate 30º and size up 3x), 
click on the relevant function buttons once. Size and Scale cannot be used together. 
 
To Use: 
 

1. Draw curve and keep selected 
2. Click on “Surface” menu, then on “Transform”  
3. Change settings as necessary 
4. Click “OK”  
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OTHER SURFACE OPERATIONS: 
 
CYLINDER: 
 Creates a pre-set cylinder, with a diameter and length of 2mm. 
 
CONE: 
 Creates a pre-set cone, with a diameter and length of 2mm. 
 
SPHERE: 
 Creates a pre-set sphere, with a diameter of 2mm. 
 
REVERSE: 
 Reverses the order of CVs on the U-Curve 
 
DIVIDE: 
 Puts a number of CVs/Sections between the existing CVs/Sections. 
 
STEP: 
 Changes the number of times the computer calculates a curve between CVs. The default is 8 
times. The more calculations there are, the less facetted the surface. (Normally used to increase the 
resolution prior to manufacture). 

eg. 
The surface on the left has a step of 2, whereas the 
surface on the right has a step of 8. 
 
 
 
 
 

SWAP U/V: 
Changes which curves are designated as U-Curves and V-Curves. Does not change the 
shape of the object. 

 
FLIP NORMAL: 

Flips the “Normal” of the surface. The “Normal” is an imaginary direction, running 
perpendicular to the surface, directly outwards. 

 
OFFSET SURFACE: 
 Creates a new surface a distance off the original. 
 
V-CURVES: 
 Close:  Closes the V-Curves of a surface 
 Open:  Opens the V-Curves of a surface 
 Reverse: Reverses the direction of the V-Curves of a surface 
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MISCELLANEOUS MENU: 
 
BOOLEAN:  
 

Creates an object from two (or more) existing objects. (see “Boolean Menu”)  
 
BLOCK: 
 
 Creates a Block Object. 
 
 A Block, like any solid, is comprised of curves. Instead of having two curves (one for the 
cross-section, and one joining the cross-sections), a Block object is like an extended surface, but 
uses curves to define positive and negative space. The anti-clockwise curves define positive space 
(solid) and clockwise curves, running in the opposite direction, create negative space (holes). Block 
objects cannot be deformed using the Deform commands. 
Eg: 
 

  
 
JEWEL: 
 

Creates a pre-drawn jewel.  
 

The jewels are 1mm x 1mm, except the Taper, which is 2mm x 0.8mm. The Jewels are not 1mm 
deep, however. 

 
 
FACET OBJECT: 
 
  Flat Shaded:  shows individual facets when the object is rendered 
  Smooth Shaded: smooths facets when rendered 
  Flip Normal:  reverses the Normal direction of Facet Objects 
  Extend to Solid: creates an extended surface from a Facet Object
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TEXT: 
 
 Adds text to the drawing. 

 

 
 

1. Type text in the box 
2. Click on “Set Font” and choose font, font style, size etc (just like in Word or Works)  
3. If “Create Block Text” is ticked, when you click OK will open the Block Menu (See 

previous page). Uncheck to create curves first. 
4. Click “OK”  

 
Text is created as curves, but with point-to-point lines, not smooth curves. 
 

Create Block Text: 
Creates block surfaces from the text. Block objects cannot be deformed (bent, twisted etc). 

 
Set Font: 

Brings up a dialogue box, allowing you to alter Font, Bold, Italics etc and Font Size. 
 
T-LINE: 
 
 Allows you to draw a T-Line.  (construction line to define boundarys) 
 

1. Click “T -Line”  
2. Hold mouse button down in screen and drag: 

Horizontal for a Vertical T-Line, Vertical for a Horizontal T-Line 
 
RENDER TO FILE: 
 
 Render the model and save as a bitmap file 
for printing, with facility to adjust resolution etc. 
 

1. Position model in 3D View. 
2. Select Render To File from Menu. 
3. Change settings, as necessary 
4. Click “OK”. BMP file will be created.  

 
File Name (Browse): 
 Name the file and its location 

Resolution: 
 The picture size, in pixels. 

Anti-aliasing: 
 The amount of smoothing. 

 

The resulting file can be opened in any graphics program to be printed. 
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CUT INTO SLICES: 
 
 Slices the model for Prototyping and saves 
as a .slc file. 

1. The model is always sliced so that the 
cross sections are viewed in the TOP 
view. 

2. Select Cut Into Slices from the Misc 
menu. 

3. Change settings as required 
4. Click Ok 

 
Slice File: 

The filename and location of the .SLC file 
Click Button to browse hard drive. 
 

Slice Thickness: 
The thickness of the slices, from 0.0127mm to 0.0762mm 
 

Slice Output Unit: 
Translates the arbitrary units of JewelCAD into an actual measurement for slicing. Drop 
menu down to change. 

 
Advanced Settings: 
 
XY Resolution: 

Defines the detail of each slice. The higher the resolution, the higher the quality, but also a 
larger file size. 
 

Also output STL File: 
Translates the Slice file into an STL file after slicing. Can be either ASCII or Binary STL. 
 

Auto XY offset: 
Automatically moves the drawing so all co-ordinates are positive in the X/Y directions. 
 

Auto Z offset: 
Automatically moves the drawing so co-ordinates are positive in the Z direction. 

 
SHOW SLICES: 
 
 Displays slices of a .SLC file.  
 

1. Select Show Slices from the Misc Menu 
2. Will open last file that was sliced. 
3. To open a different file, Click the open 

folder button to open another file. 
4. Find and select file and click “Open”  

  The “<” button will display all layers.  
  Slicing a file and looking at the slices is a good 
way to check if objects are joined/overlapped etc. 
The slices are exactly what will be produced. 
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ESTIMATE: 

 
Weight: 
 Calculates the weight of the drawing. 
 

 
 

1. Select Estimate > Weight from the Misc Menu. 
2. Type in Specific Gravity the desired material (ie. Diamond SG = 3.52) 
3. Click “OK”  

 
Volume: 

  Calculates the volume of the drawing 
 

1. Select Estimate > Volume from the Misc Menu 
 

Centre of Gravity: 
Calculates the centre of gravity for the drawing. Use to check pendants will hang 
straight 

 
1. Select Estimate > Volume from the Misc Menu 
 

MEASURE DISTANCE: 
 
 Allows you to measure the distance between two points. 
 

1. Make sure the drawing is in Wire frame. 
2. Select “Measure Distance” from the misc Menu  
3. Click on a point. The co-ordinates of the points, and the distance between them is 

displayed in the Status Bar. First measurement will be from the world origin to the point. 
4. Click on next point. This measurement will be from the previous point. 
5. Measurements at the surface can be made by viewing the drawing in “Shading In 

Colour” Mode.  
6. To exit from Measure Mode, click on Pick Button. 

 
COUNT ROUND JEWEL: 
 
 Counts the number of round jewels in your drawing 
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BOOLEAN MENU 
 

Creates an object from one or more 
 

UNION: 
 
 Joins 2 or more objects together.  
To Use: 

 

Select objects to be grouped 

 
Click on Boolean-Union button 

 
 
 
INTERSECT: 
 
 Leaves the material which is common to both of 2 overlapping objects.  
 

 

Æ 

 
 
To Use: 

 

Select two objects. 
(Cannot be more than two. Each object can be a 

Boolean object) 

 
  

Click on Boolean- Intersect Button 
 

  
The object won’t appear to change. However, a new object will be created.  

Shade or Render the view to see the new object. 
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SUBTRACT: 
 
 Cuts one object out of another, where they overlap. 
 

 

�
 

 
 
To Use: 
 

Select object(s) to cut out 

 
  

Click on Boolean-Subtract button 
 

  

Click on object to cut from 

 
  

 
 
DIS-BOOLEAN: 
 
 Breaks a Boolean object up into its constituent parts 
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Appendix 1: Buttons 
 

VIEW MENU 
 

 
Fine Snap Reduces the size of the ‘snap’, for fine drawing work.  

   

 
Quick Wire 
Frame Views drawing using a minimum number of lines. 

   

 
Normal Wire 
Frame Views drawing using a normal number of lines. 

   

 
Wire Mesh Views drawing as a wire mesh 

   

 
Fast Shading Colours drawing simply. Does not show Boolean objects. 

   

 
Shading in 
Colour Shades drawing, showing Boolean objects. 

   

 
Render Renders drawing to look realistic. 

   

 
Front View Views drawing from the front. 

   

 
Right View Views drawing from the right. 

   

 
Top View Views drawing from the top. 

   

 
Back View Views drawing from the back 

   

 
Left View Views drawing from the left 

   

 
Bottom View Views drawing from the bottom 

   

 
3D View Views drawing in rotatable 3D. 

   

 
Front and Right Splits screen into front and right views. 

   

 
Top and Front Splits screen into top and front views. 
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Four View Splits the screen into top, right, front and 3d views. 

   

 
Alt. Four Views Splits the screen into bottom, left, back and 3d views. 

   

 
Pan Up Moves the view up. 

   

 
Pan Down Moves the view down. 

   

 
Pan Left Moves the view left. 

   

 
Pan Right Moves the view right. 

   

 
Zoom In Zooms in on the drawing 

   

 
Zoom Out Zoom out from the drawing 

   

 
Zoom Window Zooms in on a specific area of the drawing. 

   

 
View All Shows all of the drawing. 

   

 
View 1:1 Zooms the image so that 1cm on the drawing is 1cm on the 

screen 
   

 
Flip Up Rotates the 3D view up. 

   

 
Flip Down Rotates the 3D view down. 

   

 
Flip Left Rotates the 3D view left. 

   

 
Flip Right Rotates the 3D view right. 

   

 
Roll Left Rolls the 3D view to the left. 

   

 
Roll Right Rolls the 3D view to the right. 

   

 
Reset View Resets the view. 
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TRANSFORM MENU 

 

 
Move Moves object along one axis using left mouse button. Use 

right mouse button to move in both axes. 
   

 
Size 

Resizes picked objects. Left button In all axes 
proportionally,  Right mouse button will resize along one 
axis only. 

   

 
Flip Rotates object around either vertical or horizontal axis. 

   

 
Rotate Rotates object around in-out axis. 

   

 
Object Axis Makes functions work from the object’s origin and axes, not 

the world origin. 
 
COPY MENU 

 

 
Cut & Paste Cut and pastes objects. 

   

 
Vertical Mirror 
Copy Copies objects across the vertical centre-line. 

   

 
Horizontal 
Mirror Copy Copies objects across the horizontal centre-line. 

   

 
180º Revolve 
Copy Copies objects 180º revolved from original 

   

 
Cycle Copy Copies objects across both centre-lines. 

   

 
Extend Copy Copies objects in a direction. Number of copies and distance 

between objects must be specified. 
   

 
Revolve Copy Copies objects around the in-out axis. Number of copies and 

angle between objects must be specified. 
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DEFORM MENU 
 

 
Bend Bends objects. 

   

 
Bend (2 Sides) Bends objects in two directions. A doming effect 

   

 
Taper Tapers objects. 

   

 
Taper (2 Sides) Tapers objects in two directions 

   

 
Scaled Taper Combines Resize and Taper functions. 

   

 
Scaled Taper (2 
Sides) Scale-Tapers objects in two directions 

   

 
Skew Skews objects/points, pivoting on an axis 

   

 
Skew (2 Sides) Skews objects/points, pivoting on an axis in two directions 

   

 
Twist Twists objects around an axis. 

   

 
Skew-twist Same as Twist, only preserves shape in the other view. 

   

 
Whirl Whirls objects around centre-line. The further the points are 

away from the centre, the further they are rotated. 
   

 
UV-Map Maps multiple objects onto a surface or curve, along all 

axes. 
   

 
Project-Map Projects objects/points onto a surface or curve, along one 

axis. 
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CURVE MENU 
 

 
Simple Curve Draws a curve point-by-point 

   

 
Vertical Mirror 
Curve Any points drawn are mirrored across the vertical axis. 

   

 
Horizontal 
Mirror Curve As above, only mirrored across the horizontal axis. 

   

 
180º Revolve 
Curve Copies points, 180º rotated from each other. 

   

 
Cycle Curve Any points drawn are mirrored across both axes. 

   

 
Extend Curve Repeats points a chosen distance away in a straight line. 

   

 
Revolve Curve Repeats points at a chosen angle, around a circle. 

   

 
Circle Draws a circle. 

   

 
Close Curve Joins start- and end-points together. 

   

 
Open Curve Opens a curve at start and end points. 

 
SURFACE MENU 
 

 
Extend Surface Creates a 3D object with straight sides from a cross-section 

curve. 
   

 
Vertical 
Revolve Surface 

Revolves a cross-section curve around the vertical centre-
line. 

   

 
Horizontal 
Revolve Surface 

Revolves a cross-section curve around the horizontal 
centre-line. 

   

 
Loft Surface Joins cross-section curves together to form a surface. 

   

 
Pipe Surface Sweeps a cross-section curve along a singe path,( curve). 

   

 
Rail Surface Sweeps a cross-section curve between rails. 
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BOOLEAN MENU 

 

 
Union Makes all selected objects into one object. 

   

 
Intersect Creates an object where two selected objects overlap. 

   

 
Subtract Cuts one object from another. 

   

 
Dis-Boolean Undoes any Boolean action that has been performed on an 

object. 

 
Appendix 2: 

Approximate Ring Diameters 
 

Size Diameter Size Diameter Size Diameter 
A 12.05 L 16.4 W 20.7 
B 12.45 M 16.8 X 21 
C 12.9 N 17.2 Y 21.4 
D 13.25 O 17.6 Z 21.8 
E 13.65 P 18 1 22.2 
F 14 Q 18.4 2 22.5 
G 14.4 R 18.75 3 22.8 
H 14.8 S 19.1 4 23.2 
I 15.2 T 19.5 5 23.6 
J 15.6 U 19.9 6 24.6 
K 16 V 20.3   

 

Appendix 3: 
Approximate weights of diamonds.  Based on Round Brilliant-cut. 

 
Carat Diameter Carat Diameter Carat Diameter 

125pc (0.008) 1.25 0.20 3.8 1.50 7.4 
0.01 1.4 0.22 3.9 1.60 7.6 

70pc (0.015) 1.5 0.23 4.0 1.75 7.8 
0.02 1.7 0.25 4.1 1.90 8.0 

40pc (0.025) 1.8 0.30 4.2 2.00 8.2 
0.03 2.0 0.33 4.4 2.15 8.4 

0.035 2.1 0.38 4.6 2.25 8.6 
0.04 2.2 0.40 4.8 2.50 8.8 
0.05 2.4 0.47 5.0 2.65 9.0 
0.06 2.5 0.50 5.2 2.85 9.2 
0.07 2.7 0.60 5.4 3.00 9.4 
0.08 2.8 0.65 5.6 3.15 9.6 
0.09 2.9 0.75 5.8 3.35 9.8 
0.10 3.0 0.80 6.0 3.50 10.0 
0.11 3.1 0.85 6.2 3.75 10.2 
0.12 3.2 0.95 6.4 4.00 10.4 
0.14 3.3 1.00 6.5 4.25 10.6 
0.15 3.4 1.10 6.6 4.45 10.8 
0.16 3.5 1.17 6.8 4.75 11.0 
0.17 3.6 1.25 7.0 5.00 11.2 
0.18 3.7 1.33 7.2   

 



INDEX 
 

  Curve cont:  A   Reverse 48 
Axes: 1  Split 48 

   Offset 48 
Adjust (curve): 48    
   Cut into Slices: 64 

    B   Cut & Paste: 20 
Background:     

Changing 9  CV:  
   Deleting 39 

Bend: 29  Hide 6 
   Show 6 

Bend (2 Sides): 30    
   Cycle:  

Be Jewel: 6  Copy 23 
   Curve 42 

Block: 62    
    

Boolean: 66  D  
   Database:  

Buttons:   Accessing 14 
Adding/Removing 11  Adding to 14 
List 68  Location of 14 
Moving 1  Saving Pictures to 14 
     

BMP Files: 4, 14, 63  Deform Menu: 29 
     

  Delete:  C   CV 39 
Circle: 45  Object/Curve 6 

     
Close:   Dis-Boolean: 67 

Curve 48    
Surface 61  Divide:  
   Curve 48 

Colours:   Surface 61 
Changing 4    
    

Copy Menu: 20  E  
   Edit:  

Curve:   Menu 6 
Adjust 48  Material 8 
Draw 39    
Divide 48  Exit: 5 
Join 48    
Menu 39  Export: 4 



Extend:    
Copy 24  J  
Curve 43  Jewel:  
Surface 50  Be Jewel 6 
   Creating 62 
   Hide 6 
   Not Jewel 6 

  Pick 13 F     
Facet Object: 3, 62  Join Curves: 48 

     
Fast Shading: 10, 74   

   L  
File Menu: 4  Left Rail: 54-55 

     
Fine Snap: 10  Language:  

   Change 5 
Flip:     

Normal 61  Line: 47 
Transform 18    
View 10  Loft Surface: 52 
     

   G   M  
Grid: 9  Multiple CVs: 39 

     
  Material:  H   Create/Edit 8 

Helix: 47    
   Move: 16 

Hide:     
CV 6  Measure Distance: 65 
View 6    
Jewel 6    
Swap 6    
    

Horizontal Mirror:   N  
Copy 22  New: 4 
Curve 41    
   Not Jewel: 6 

    I   Non-Deformable: 7 
Intersect: 66    

   Not Super Subtracter: 7 
Insert: 4    

    
Import: 4  O  

   Object Layer: 7 
     

   Object Axis: 15, 19 



Offset:   Scale: 15, 17 
Curve 48    
Surface 61  Scaled Taper: 32 

     
Open:   Scaled Taper (2 Sides): 32 

Curve 48    
File 4  Shading in Colour: 10 
Surface 61    

   Show:  
  CV 6 P   Jewel 6 

Pick Menu: 12  Slices 64 
     
Pictures:   Simple Curve: 40 

For database 14    
Printing 63  Size: 15, 17 
     

Pipe Surface: 53  Skew: 33 
     
Polygon: 47  Skew (2 Sides): 33 
     
Project-Map: 36  Skew-Twist: 34 

     
  Split Curve: 48 R     

Rail Surface: 54-59  Step: 61 
     

Render: 10  Subtract: 67 
     

Render to File: 63  Super Subtracter: 6 
     

Revolve:   Surface:  
180º Copy 23  Creating 49 
180º Curve 41  Editing 12 
Copy 26  Menu 49 
Curve 44  Picking 12 
Surface 51  Reverse 61 
     

Reverse:   Swap Hide: 6 
Curve 48    
Surface 61   
   T  

Roll: 19  T-Line:  
   Create 63 

  Pick 13 S     
Save: 4  Taper: 31 

     
Save Views: 4  Taper (2 Sides): 31 
     



Text:    
Adding 63  W  
Altering 63  Weight: 65 
     

Toolbars:   Whirl: 35 
Adding/Removing 11    
Moving 1  World Origin: 2, 15, 17 

     
Transform:     

Copy 27    
Curve 46    
Menu 15    
Surface 60    
     

Twist: 34    
     

    U     
U-Curve:     

Open/Close 61    
Reverse 61    

     
Undelete: 6    

     
Undo: 6    

     
Union: 66    
     
UV Map: 37    
     

     
    V     

V-Curve:     
Open/Close 61    
Reverse 61    

     
Vertical Mirror:     

Copy 22    
Curve 40    
     

Vertical Revolve      
Surface: 51    

     
View:     

Menu 9    
Change 10    
     

Volume: 65    
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